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1. Removed Restriction on Lens Barrel Tool 

(Contour Face Cut) 

It is now possible to select contour face cut machining when using lens barrel tools. This 

function allows you to perform rough and finish machining of contour using lens barrel 

tools. 

 

 Setting Screen 

 

  

 Tool Setting 
 

 Machining Parameter Setting 
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2. Removed Restriction on Lens Barrel Tool 

(Stock Support) 

It is now possible to read and save stock files when using the lens barrel tool. This function 

allows you to accurately identify the uncut portions after using lens barrel tools and create 

machining without waste in the next process. 

 

 Setting Screen 

 

  

 Tool Setting 
 

 Uncut Geometry Setting 
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3. Addition of Function to Specify the 

Progress Direction for Tool Path 

A function has been added to obtain the progress direction for the tool path from the 

geometry when "One-way" or "Zigzag" is selected for scan motion or contour face cut 

motion.  

For index machining function, even in the case of machining where the angle of the scan 

motion is unclear, you can now set the progress direction without measuring or by trial and 

error. 
 

The following machining types can be set. 

 Projection Machining 

 Specify Projection Direction of Contour Projection Machining 

 Flat Face Machining 

 Contour Face Cut Machining 

* Any one of the machining types can be set when the Path Operation is "One-way" or 

"Zigzag". 

 Examples for the Creation of Index Machining Data 

 

(1) Results of setting zigzag motion in the X-axis 

direction using the previous function 

(2) When using "Function to Specify the Progress Direction for Tool Path" with 

FFCAM 2019 

In [Path Direction Setting] (Example:  

2 Points), specify the edge of the blue 

arrow. 

The tool path is output in the X-axis 

direction before the index setting. 

The tool path is output in the X-axis 

direction after index setting. 
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 Setting Screen 

 

 

  

 Projection Machining 

  
 Specify Projection Direction  

(Contour Projection Machining) 

  

Click the [Set] button in [Path Direction] of Projection Machining, Specify Projection 

Direction of Contour Projection Machining, Flat Face Machining, or Contour Face Cut 

Machining. 

Set the path direction in the displayed [Path Direction Setting] screen. 

Operation examples: 
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(1) X + Direction, X - Direction, Y + Direction, Y - Direction 
Set the progress direction for the tool path to the X axis and Y axis (+/-) direction of the 

machining coordinate system. 

 

 

(2) Set Angle 
Specify an angle for the +X axis of the machining coordinate system, and set the path 

direction. 

 

 

(3) 2 Points 

Select two points on the geometry.  

The path direction is set along the straight line that connects the two points.  

The first point is the start point of the vector, and the second point is the end point of 

the vector. 

 

  

A white arrow showing the path direction is 

displayed when the second point is selected. 
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(4) Contact Line 
Select a point on the curve or edge of the geometry. 

The contact line direction of the selected point is set as the path direction. 

 

 (Endpoint, Middle point) 
 

Select the endpoint or midpoint of the curve or edge. 
 

  (Point on Curve) 
 

Select an arbitrary point on the curve or edge. 
 

Invert the Direction 

Reverses the path direction that is set in the point selection. 

 

(5) Surface Vertical 
Select a face on the geometry. 

The normal direction of the selected face is set as the path direction.  

Note that when the face is a curved surface, the normal direction of the selected 

position is the path direction. 

 

Reverse Direction 

Reverses the path direction that is set in the face selection. 

A red arrow showing the path direction is 

displayed when you select a point on the 

curve or edge. 

On selecting a face, a red arrow is 

displayed to indicate the path direction. 
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 Note 
 

 An error message is displayed when the path direction and the tool axis direction are 

set to the same direction. 

 If the index angle is set and "2 Points" or "Contact Line" is specified, and the setting 

is done away from the machining surface, the tool path may deviate from the 

specified details. 
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4. Addition of Common Machining Start 

Point Setting for Drilling 

A common machining start point can now be set at the start/end point of drilling.  

Since the start/end point of multiple drilling points can be defined together, the work time 

can be reduced, and rework due to missing the settings can be eliminated. 

 

 Setting Screen 

 

 

  

 Hole Process (Process Setting) 
 

 Drilling (Machining Parameter 
Setting) 

 

[Common Start Point Setting] field has 

been added. 

From the [Start/End Point] drop-down 

list, you can select "Common Machining 

Start Point". 
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5. Addition of Function to Obtain 

Pre-Machining Information 

The setting values of the pre-machining tool and finishing allowance of pre-machining for 

Corner R Machining and Contour Machining (when [Tool Load Priority] is specified in the 

machining order) can now be obtained from the pre-machining.  

FFCAM 2018.2 or earlier required users to input a value for pre-machining.  

In FFCAM 2019, the value set in the pre-machining can be obtained by just clicking the 

[Acquisition of Pre-machining tool/Finishing allowance] button.  

Even if you forget the pre-machining information, you can set the pre-machining information 

without returning to pre-machining screen for confirmation. 
 

 Setting Screen 
 

[Acquisition of Pre-machining tool/Finishing allowance] button has been added. 

 

 Note 
 

 If pre-processing information is not present, the [Acquisition of Pre-machining 

tool/Finishing allowance] button cannot be used. 

 When a pre-machining tool is registered to Corner R Machining, the setting value 

cannot be acquired if the pre-machining tool is Lens Barrel tool. 

  

 Corner R Machining 
 

 Contour Machining 
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6. Addition of Machining Direction Setting 

Function Independent of Machine 

Configuration 

In index machining of FFCAM, the machining direction is set by directly entering the angle 

for the machine rotation axis. However, in the case of machines where the rotation axis is 

not parallel to the X/Y/Z axis, setting the required angle was sometimes difficult. 

In FFCAM 2019, a function to set an angle based on X/Y/Z axis has been added.  

You can set an angle regardless of the machine axis configuration. 
 

 Setting Screen 

 

Direction Setting 
Absolute Coordinate Ref. 

The machining reference of the angle set in the [Direction Setting] screen is the 

coordinate system of the model. 

 

On clicking , the [Direction Setting] 

screen is displayed. 

The [Direction Setting] screen displays 

the A/B/C axis rotation angle by 

converting it to the X/Y/Z axis rotation 

angle. 

Here, if you change the value of X/Y/Z 

axis rotation angle, it is converted to the 

A/B/C axis rotation angle and set as the 

machining direction. 
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Specified Coordinate Ref. 

The machining reference of the angle set in the [Direction Setting] screen is an 

arbitrary coordinate system. 

When the [Specified Coordinate Ref.] radio button is selected, the value of the X/Y/Z 

axis becomes "0", and the rotation angle of each axis is input. 
 

 

Sets the machining reference point of the angle set in [Direction Setting] screen to an 

arbitrary position on the model.  

 

An "orange" coordinate axis and "blue" plane are displayed at the machining reference 

point. 

* The default machining reference point is the same position as the model origin. 

 

 

When the  button is selected, the value of the X/Y/Z axis becomes "0", and the 

rotation angle of each axis is input. 
 

OK 

The X/Y/Z axis rotation angles changed in the [Direction Setting] screen is converted to 

the A/B/C axis rotation angles and the machining direction is set.  

(The [Direction Setting] screen closes.) 
 

Apply 

The X/Y/Z axis rotation angles changed in the [Direction Setting] screen is converted to 

the A/B/C axis rotation angles and the machining direction is set.  

(The [Direction Setting] screen does not close.) 
 

Cancel 

Discards the changes and closes the screen. 

The geometry coordinate axes set in the 

[Path Direction] screen are displayed in 

"orange" and plane in "blue". 

 

The geometry's coordinate axes are 

displayed in "green" and plane in "red". 
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 Setting Example 
 

 Angle Setting When Machining the Groove in the Green Part of the 
Geometry Below 

 

1. Click .  

[Direction Setting] screen is displayed. 

 

2. Enter "-65 degrees" for the X-axis rotation and "-45 degrees" for the Z-axis 

rotation and click [Apply].  

The "orange" coordinate axes and "blue" plane are oriented in the specified 

direction. 
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3. Click [OK] to close the [Direction Setting] screen.  

The values calculated for the machine rotation axis will be set in [Machining 

Direction].  

Also, in the graphics window, the coordinate system of the geometry (green 

coordinate axes and red plane) is changed to the set direction. 

 

 Note 
 

When you start the [Direction Setting] screen again after setting the indexed angle, the set 

indexed angle is converted to the X/Y/Z axis rotation angles again and displayed.  

Since the input values of the [Direction Setting] screen are not stored, the X/Y/Z axis 

rotation angles may be different from the previous input values if you open the screen 

again. 

  

 

Image after setting 
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7. Enhancement of Path Calculation Type 

When Process is Selected 

In FFCAM 2018.2 or earlier, calculation methods such as batch calculation could not be 

executed during path calculation when a process was selected.  

In FFCAM 2019, calculation methods such as batch calculation can be executed even 

when a process has been selected. 
 

 Setting Screen 

 

 Note 
 

If multiple processes are selected, [Path Calculation], [Blanket Path Registration], [Batch 

Calculate], and [Blanket Batch Registration] cannot be executed. 

  

[Batch Path Calculation] and [Blanket Batch Registration] can be executed when a 

process has been selected. 
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8. Addition of Function to Open the 

Location for Saving FFCAM Data 

To check files (such as NC, CSV, and INF) created with FFCAM, the folder where the files 

are stored may be opened in Windows Explorer.  

If the files are saved in folders buried deep in the folder hierarchy, many folders have to be 

opened before you can reach the target folder.  

In FFCAM 2019, you can now open the folder where the file used at present is saved with 

one click. You can easily access the required folder. 
 

 Setting Screen 

 

* The [Open a designated folder] can also be selected from the menu that is displayed by 

right-clicking on the list of "Process" or "Machining" in the Machining Data Selection screen. 

 

 Explanation 
 

This function refers to the "Results" folder of the work data by default.  

The reference location can be changed in the [Option Set Screen] -> [Ref. folder] -> [Open 

a folder] field. 

From the toolbar of the Machining Data Selection screen, click on  (Open a 

designated folder) to open the folder where the file is saved. 
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9. Improved the Method of Specifying Working 

Folder When a New File is Created 

When a new file is created with FFCAM, it is necessary to specify the location where the 

geometry data and FFCAM work data has to be created.  

In the file operation method of FFCAM 2018.2 or earlier, when matching the designated 

folder of geometry data with that of FFCAM work data, you had to specify the same folder 

twice to select the geometry and working folder.  

In FFCAM 2019, a function to automatically set the working folder to the folder where 

geometry data exists has been added. You can start the creation of a new file smoothly. 
 

 Setting Screen 
 

When using the function to create a working folder automatically 

 

Designates a working folder 
Check ON 

Specify a working folder when creating a new file. (Old function) 
 

Check OFF (Default) 

If geometry data is selected when creating a new file, the working folder is set to the 

folder where geometry data exits. (New function) 

When using the function to create a working folder automatically, set the working folder 

from [Option Set Screen] -> [File Related]. 

By selecting a geometry, 

the working folder is set 

to the folder where 

geometry data exits. 
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10. Change in NC File Output Destination 

During Reposting 

In FFCAM 2018.2 or earlier, when working data was saved as new, the location of the file 

before saving by Save As was specified as the NC file output destination at repost.  

For this reason, it was not possible to identify the output NC file, and the output destination 

of the NC file had to be changed.  

In FFCAM 2019, the NC file output destination at repost is now automatically changed to 

the Results folder of the file that is saved by Save As. 
 

 Setting Screen 

 

NC file output destination before saving working data by Save As 

Save working data by Save As 

The NC file output destination is changed to the Result folder of the working data 

after saving by Save As. 
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11. Addition of Function to View Files as 

Thumbnails 

The saved FFCAM file (.xMtn) is now displayed with a thumbnail of the geometry image in 

Windows Explorer. Since the model geometry can be confirmed without opening the file, 

making file selection easier. 
 

 Explanation screen 

 

 Note 
 

Thumbnails are not displayed for xMtn files that have not been saved in FFCAM 2019. 

  

xMtn files are displayed with a thumbnail. 
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12. Addition of Comment Display Function 

for Files 

Comments can now be added to FFCAM files (.xMtn).  

The comments that are added can be viewed and checked in Windows Explorer.  

Using it together with the Function to View Files as Thumbnails of the previous chapter 

makes file selection in FFCAM easier. 
 

 Setting Screen 

 

Go to [File] -> [File property] to open the window for entering comments. 

Enter the comment and click [OK]. 

When you select the xMtn file in Windows Explorer, the entered comment is displayed 

in the preview window. 
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13. Addition of Comment Display Function 

for Process 

Comments can now be added to processes.  

You can record and convey the details and production intention of the machining that has 

been created by entering the explanation for the machining, and matters to be handed over. 
 

 Setting Screen 

 

 Supplementary Note 
 

A command to output "Process Comment" has been added to the insert statement macros 

and output parameter lists on the FFPOST Edit Form. 

 

Comments can be entered and confirmed in the [Process Setting] screen. 

Up 40 double-byte characters or 80 single-byte characters can be entered for comments. 

 Milling Machining 

  
 Drilling 

  

Comments can be entered and confirmed in the Machining Data Selection screen. 

 Insert Statement Macros 
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14. Enhancement of Comment Display 

Function for Machining 

The size of the entry field for machining comments has been increased.  

Even if a long comment is entered, the whole comment can be viewed.  

Up 40 double-byte characters or 80 single-byte characters can be entered for comments. 
 

 Setting Screen 

 

 

  

 Milling Machining 
  

 Drilling 
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15. Enhancement of Tip Comments for 

Parameters 

The number of parameters displaying tip comments for machining definition has been 

increased.  

The summary of parameters whose usage is difficult to understand only by their name can 

be confirmed without opening HELP.  

In FFCAM 2019, tip comments of the machining condition settings have been added.  

In future versions, additional tip comments will be added. 
 

 Operation Screen 

 

 

  

Examples of tip comment display: 

Mouseover 
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16. Addition of Blank Operation Icon to 

Toolbar 

A blank operation icon has been added to the toolbar.  

In FFCAM 2018.2 or earlier, blank operations had to be done from the [Edit] menu.  

In FFCAM 2019, since the blank function can be executed from the toolbar, the time 

required to execute the blanking operations can be reduced.  

The functions displayed as icons are easy to find and the operability is improved. 
 

 Setting Screen 

 

  

Icons for blank operations are provided on the toolbar.  

(Functions of each icon are the same as that of the Edit menu. See the figure below.) 

The icons are also displayed in the menu. 
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17. Change the Default Machine Parameters 

The default of [Decimal Point Output] of the machining parameter has been changed to 

"Yes".  

* Applies to all machines registered to the machining parameter by default. 

 Setting Screen 

 

 

  

Example: Machining parameter of machine "V33i" 
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18. Addition of Function to Set the Hole to 

the Center of Geometry Direction in the 

Machining Preparation Wizard 

A function to set the hole direction to the center of the geometry has been added to the setting 

list of [Hole Position] of the Hole Machining Data Creation of Machining Preparation Wizard. 

You can align the direction of the selected hole to the center direction of the geometry. 

 Operation Screen 

 

* A marker can be displayed at the center of the geometry.  

For details, refer to 20. Addition of Function to Display the Center of Geometry in the 

Machining Preparation Wizard. 

1. When setting with [Hole Position] of Machining Creation Wizard, the hole direction of 

each hole is displayed by an arrow.  

* In the example below, the hole direction is from the inside to the outside of the geometry. 

 

2. Select a hole to modify the hole direction from the selection list.  

Click the  (Hole direction is towards the center of Box) button.  

The direction of the selected hole will be towards the center of the geometry (from the 

outside to the inside). 
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19. Addition of Function to Set the Direction 

of Hole to the Specified Point in the 

Machining Preparation Wizard 

A function to set the hole direction to the specified point has been added to the setting list 

of [Hole Position] of the Hole Machining Data Creation in Machining Preparation Wizard.  

You can align the direction of the selected hole to the specified direction. 
 

 Operation Screen 

 

2. Select [Coordinate value specification method] in the Select screen.  

Pick and specify a point on the geometry that will serve as the reference for the hole 

direction.  

A marker appears on the specified position. 

 

1. Select a hole to modify the hole direction from the selection list of [Hole Position] 

settings.  

Click the  (Hole direction is towards the designated point).  

The Select screen appears. 
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3. Click the [OK] button in the Element Selection screen.  

The direction of each hole will be towards the direction of the specified position 

(Example: From the outside to the inside). 
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20. Addition of Function to Display the 

Center of Geometry in the Machining 

Preparation Wizard 

A function to indicate the geometry center using a marker has been added to the setting list 

of [Hole Position] of the Hole Machining Data Creation of Machining Preparation Wizard.  

The geometry center can be confirmed in the graphics window. 
 

 Operation Screen 

 

  

Click the  (Indicates the center of BOX) button in the selection list of [Hole Position] 

settings. 

A marker appears at the geometry center. 
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21. Addition of Surface Filter Function in the 

Machining Preparation Wizard 

The [Surface] (Surface Normal Direction) item has been added to the search filters of [Hole 

Position] of the Hole Machining Data Creation in Machining Preparation Wizard.  

When selecting a hole to be machined, only holes on the selected surface can be registered. 
 

 Operation Screen 

  

1. Select the [Surface] checkbox in the search filter of [Hole Position] setting, and click 

the [Face set] button.  

The Element Selection screen appears. 

2. Select a surface of the geometry, and click the [OK] button in the Element Selection 

screen. 
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3. Only holes on the selected surface are registered in the setting list. 
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22. Improved Machine Display Function 

During Measurement in Simulation 

Machine geometries are no longer hidden even when measurement information is used 

during simulations in machine display.  

Measurement can be carried out while the geometry is setup has been completed. 
 

 Setting Screen 

 

 

  

Machine geometries are not hidden even if the measurement data is used. 
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23. Addition of Work Coordinate System 

Display Function in the Confirmation 

Machine Posture 

The coordinate system image after the rotation axis operation is now displayed during the 

confirmation machine posture.  

The workpiece geometry and direction of the machining reference point after the rotation 

axis operation can be confirmed. 
 

 Setting Screen 

 

 

  

[Confirmation Machine posture] screen displays images of the workpiece coordinate 

system and machine coordinate system, respectively. 

Machine coordinate system 

Workpiece 

coordinate system 
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24. Change in the [Max. Length in One 

Block] Parameter in 5-Axis Simultaneous 

Movement 

For 3-5 axis conversion machining, it is now possible to select whether to use [Max. length 

in one block] parameter of 5-axis simultaneous movement.  

"OFF (do not use)" is selected by default. This parameter is no longer mandatory, so set 

this parameter as needed. 
 

 Setting Screen 

 

Max. length in one block 
Check OFF (Default) 

The parameter of Max. length in one block is not used. 
 

Check ON 

The parameter of Max. length in one block is used and set. 

 

 Note 
 

 When importing data of FFCAM 2018.2 or earlier, the checkbox is selected ("ON"), and 

the setting value is also carried over. 

 For 5-axis dedicated simultaneous machining, the checkbox is not added. 

  

A checkbox has been added to the [Max. length in one block] parameter of 3-5 axis 

conversion machining. 
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25. Addition of Function to Specify Tool 

Contact Points in 5-Axis Dedicated 

Simultaneous Machining 

In 5-axis dedicated simultaneous (Parallel, Along Surface, Route) machining, the portion 

where the tool touches the machining work can be now specified.  

When using flat end mill and bullnose end mill tools, you can specify the part of the tool to 

be used such as "Corner" and "Bottom face". 

 Setting Screen 

 

[Tool contact point] parameter has been added to [5-axis simultaneous movement] -> 

[Detail] -> [Control of tool axis]. Select the tool contact point from the drop-down list. 

 5-Axis dedicated simultaneous machining 
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Tool Contact Point 
Auto (Default) 

The contact position between the tool and drive surface is determined automatically 

according to the tilt of the tool. 

 

Tip 

The tool position is set so that the tool tip center touches the drive surface. 

A collision may occur between the tool and workpiece depending on the geometries of 

the tool and drive surface. 

Therefore, use this parameter with [Avoid tool collision] enabled. 

 

Front 

The tool posture is set so that the front blade touches the drive surface to the progress 

direction of the tool. 

A collision may occur between the tool and workpiece depending on the geometries of 

the tool and drive surface. 

Therefore, use this parameter with [Avoid tool collision] enabled. 

 

Progress 
direction 

Contact point 
Machining geometry 

Tool 

Progress 

direction 

Contact point 

Machining geometry 

Tool 

Progress 

direction 

Contact point 

Tool 

Machining geometry 
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26. Change in Default Tool Clearance of 

Avoid Tool Collision in 5-Axis 

Simultaneous Movement 

The default tool clearance of "avoid tool collision" in 5-axis simultaneous movement has 

been changed.  

If a small-diameter pencil neck tool was set and calculated with the default tool clearance, 

the holder clearance setting value is applied to the tool tip, and an error might occur.  

By specifying the shank clearance for the tool tip in advance, calculations can now be 

performed with the default value for a tool with small-diameter and a short neck length. 
 

 Setting Screen 

 

In FFCAM 2019, the tool clearance [Select shank clearance] is set to "ON" by default.  

Shank clearance is applied to a tool tip. 

 Avoid Tool Collision in 5-Axis Simultaneous Movement 
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27. Addition of Detail Parameter for "Ignored 

Code" In Machine Simulator 

Due to the G and M codes that are not supported by Machine Simulator, unexpected 

operations may be performed during simulation.  

In Machine Simulator V.2.1, you can specify code that is not executed for simulation 

(Ignored Code) to avoid such unexpected operations.  

Codes registered as ignored code are read as NC program but do not operate during the 

simulation. 
 

 Unexpected Operations Due to Unsupported Codes 

 

"Ignored Code" has been set to avoid the above operations during simulation. 

  

Example 1: Malfunction of simulation by argument X/Y/Z of G10 macro (offset 

value setting of workpiece coordinate system) 

Example 2: Error output by macro programs not registered in NC Data Center 

  

  

Since G10 is a macro to set values in the machine, there is no actual movement of the axis. 

 

Sub programs were not registered in NC Data Center because these macros do not affect 

the simulation. 
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 Setting Screen 
 

 Registration of Ignored Code 

 

Template 
A template is required to set ignored codes. 

Create a new template, or select an existing template from the drop-down list. 
 

Add 

Creates a new template. 

On clicking [Add], the [New] screen is displayed. 

Enter a template name in the [New] screen and click [OK]. 

 
Delete 

Deletes the selected template. 

[Ignored code] setting field 
When a new template is created, or an existing template is selected, the [Ignored 

Code] setting field becomes available. 
 

Add 

Adds a row to enter the ignored code. 
 

Delete 

Deletes the selected row. 

Set the ignored codes on the [Ignore] tab in [Code setting] tab of the [Simulation 

setting] screen. 

* The conventional [Stop setting] is set from the [Stop] tab of the [Code Setting] tab. 
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(a) Setting image 

 

(b) Examples for entry of ignored codes 
 

Blocks containing strings entered as ignored code are excluded from the simulation 

operation. 

* Up to 198 single byte characters can be entered for ignored codes. 
 

Ignored code (example) Target to ignore (example) 

G100 G100 X20. Y30. H6 

G65 
G65 P9621 H1. D1. Z3.0 block 

G65 P8800 

P8800 G65 P8800 

G68 X 

G68 X20.0 Y15.0 block 

* If the order of argument specification is different 

(Example: G68 Y20.0 X15.0), the block is not subject 

to the ignored code. 

 

  

1. Click [Add] to add a row. 

2. Enter the code to be ignored on the row which is added. 

3. Repeat steps 1 to 2 depending on the number of codes to be entered. 

4. After entering all the codes to ignore, click on [Apply]. 

The template is created and registered in the Machine Simulator. 
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 Enabling/Disabling ignored codes 
 

Enable/disable an ignored code on the initial settings screen. 

Also, set the method to output to the log when an ignore code is read. 

 

Checkbox 
Toggle to enable/disable ignored code. 
 

Check ON (Default) 

Enables ignored code.  

Simulation of blocks containing ignored code is not executed. 
 

Check OFF 

Disables ignored code. 

Simulation of blocks containing ignored code is executed. 
 

Call level 
Set the call level for log output from the drop-down list. 

The default value is "Information". 
 

* For details on the call level, see 28. Enhancement of Call Level of Logs in Machine 

Simulator. 
 

 Note 
 

Combination of ignored code and stop code or breakpoint 
 

If stop codes or breakpoints have been set to a block with ignored codes, the simulation is 

paused at that block. 

 

  

Perform these setting from [Initial setting] -> [Simulation detection] tab -> [Phenomenon] -

> [Ignored code]. 
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28. Enhancement of Call Level of Logs in 

Machine Simulator 

"Information" has been added to the call level of logs of the Machine Simulator.  

Previous "Warning" and "Alarm" of call level were linked with the function to pause the 

simulation.  

"Information" logs only information without pausing the simulation.  

You can record the phenomenon of stopping and confirming the simulation and the 

phenomenon of logging only information without stopping the simulation. 
 

 Setting Screen 

 

Call level 
Alarm 

Outputs an alarm if a phenomenon occurs. 
 

Warning 

Outputs a warning if a phenomenon occurs. 
 

Information 

Outputs only information if a phenomenon occurs. 
 

Unnotify 

Outputs nothing even if a phenomenon occurs. 

* "Unnotify" can be selected only for [Ignored code].  

For details on [Ignored Code], see the previous chapter Addition of Detail Parameter 

for "Ignored Code" In Machine Simulator. 

  

Set the call level for each phenomenon from the drop-down list. 

 Initial Settings -> [Simulation detection] tab 
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 Example of Log Output 

 

  

Each phenomenon is displayed at the call level set in [Initial Settings]. 

 Log screen 
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29. Addition of Professional Data Output 

Function 

An interface that outputs data for "Collision Safeguard" and "Work Plan" has been 

integrated as [Professional Data Output] function. 

 

 Setting Screen 
On clicking [Professional data output] icon, the [Professional data output] screen is 

displayed. 
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 Output Function 
 

 Function 

Click [CSG] (Collision Safeguard) or [WP] (Work Plan) icon 

and select the output function. 

 

What is Collision Safeguard? 

It is a software which prevents interference and damage from occurring in the machining 

chamber of the machining center.  

While the machine is running, the software "prefetches the machine operation" and 

"simulates it" to stop the machine before any interference occurs. 

What is the Work Plan? 

It is a function that can collectively manage data, such as NC programs used as main/sub 

programs and data on Collision Safeguard (CSG), required to operate the machine. 

 

 

 

 

------------------------------------------------------------------------------------------------------------------------- 

 

30. Update of Parasolid Supported Version 

Parasolid V.30 is now supported. 
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